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Az elso lépések utmutatoral

Kinek sz6l ez az utmutato és mit tartalmaz?

Ez az utmutatd projektmenedzserek szamara készllt. A projekt életcikluséra fokuszal, a projekt
létrehozasatol kezdve, a projektcsomagok kezelésén at egészen a projekt befejezéséig.

MEGJEGYZES Az SDL Studio GroupShare Project szerver segitségével végzett on-line
munkafolyamatokrél az SDL Trados Studio Sugé vidediban és leirdsaiban taldl
informaciot.

Az utmutato haszndlata

Gyakorlashoz hasznélhatja a program telepitésekor kapott mintafajlokat. Minden feladat az
el6zére épll, tehat ha a mintafajlokat hasznalja, akkor az utasitasokat I1épésrél [épésre kell
végrehajtania.

l Ez a szimbélum mutatja a feladatok elvégzéséhez sziikséges mintaféjlokat
4 és azok helyét.

Az elérési Utvonalat a Microsoft Windows 7 vagy Vista operacios
rendszerek alapjan hatdroztuk meg. Ugyanezek a fajlok Windows XP
esetében a My Documents (Dokumentumok) mappéaban taldlhatok.

(DTipp Ez a szimbdlum azt mutatja, hogy az éppen végrehajtott feladattal
kapcsolatban tovabbi informacidkat tartalmazé tipp érhet6 el.

MEGJEGYZES Ez a szimbdlum azt mutatja, hogy az éppen végrehajtott feladattal
kapcsolatban fontos informaciot tudhat meg.

Billentydiparancsok Minden billenty(t, melyet le kell nyomnia billenty(izetén a kdvetkezd
karaktertipussal jeloltiink: Ctr1+Enter.

Egyéb informdcioforrdsok
Alabb talalhaté néhany informaciéforras, amelyhez hozzaférhet:
e  SDL Trados Studio Stugé
e  SDL Studio GroupShare Stigé
e  SDL Studio GroupShare Telepitési Gtmutaté
e  SDL Trados Studio Adatmigrdciés utmutaté
o Dokumentumok forditdsa és ellenérzése - ElsG lépések utmutaté

e  Forditdsi memdria menedzsment - EIsé Iépések atmutatd
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Az SDL Trados Studio-rol

Leirdas

Az SDL Trados Studio lehetévé teszi kiilonbozé szervezetek szamara, hogy forditasi
projektjeiket minden szempontbdl hatékonyan kezelhessék. Az SDL Trados Studio magéban
foglalja a projektvezetdk, forditok, szerkeszték, lektorok és egyéb nyelvi szakértdk altal hasznalt

projektmenedzsment és szamitogéppel tamogatott forditasi (CAT) eszkdzoket. Ezek kdnnyen
alkalmazhato nézetekben talalhatok, amelyeket az Onnek legmegfelelébb médon rendezhet.

Nézetek

Az SDL Trados Studio-ban egy nézet megjelenitéséhez kattintson arra a gombra, amely a nézet
nevét viseli vagy az adott nézet ikonjéra. A nézet gombok a navigéaciés panel aljan taldlhatok.

& SDL Trados Studio - Sample EN-DE
File View Project Tools Help I

\j Open Document... (g New Project... [ Open Project... O Open Package... % Open Server Project... J ; New Translation Memory...

l:, Upgrade Translation Memories @ Terminology Management @ Software Localization = Align Translated Documents

Home «

Popular Help Topics

@ Introducing SDL Trados
Studio

@ Quick Start Guides
@ Creating and Managing

Projects
@ Translating in SDL Trados

Studio

@ Upgrading your
Translation Memories

@ Open Sample Project

=¥ Fadela

3 Home

Open Document New Project Open Package Open Server
(@@l Projects Project

i/ Files
ﬁ Reports
K, Editor
i | Translation Memories S D L g?:?:l?: ={e]]]
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Nézet

““H'Home

=

Projects (Projektek)

oY Files (Fajlok)

G Reports (Jelentések)

R

“ Editor (Szerkesztd)

f Translation Memories
(Forditasi memoriak)

Leiras

A kovetkezd parancsokhoz férhet hozza:
e Ujprojekt létrehozésa
e Projektcsomagok megnyitasa

e Forditasi memoéridk |étrehozasa vagy
megnyitasa

o Alapértelmezett globalis bedllitasok
meghatéarozasa

e Az SDL MultiTerm megnyitésa, ahol
|étrehozhatja és kezelheti terminolégiai
adatbazisait

e  Forditasi memoriak frissitése

e Szoftverlokalizalas az SDL Passolo Essential
segitségével

e Leforditott dokumentumok szinkronizalasa az
SDL WinAlign segitségével

Barmely parancsra is kattint ezek kozil, az a megfeleld
nézetre valt az SDL Trados Studio-n belil vagy megnyit
egy masik alkalmazast, ahol az adott mUiveletet
elvégezheti.

Itt tekintheti meg és dolgozhat a projektekkel.
Kivalaszthat egy projektet és megtekintheti a projekt és
annak féjljainak részletes informacisit. Ezen kivil
nyomon kovetheti a projekt és fajlok allapotat.

Itt dolgozhat a projekt fjljaival. Innen:
e nyithat meg fajlokat forditasra;
e nyithat meg fajlokat ellenérzésre;
o kotegelt muiveleteket hajthat végre fajlokon;

e tovabba megtekintheti ezeknek a fajloknak a
szbszamat és forditasi elérehaladasukat.

Itt tekintheti meg a projektjelentéseket. A jelentések
részletes forditdselemzési adatokkal szolgalnak, melyek
kozvetlenil a projekttervezésben és a koltségvetés-
készités folyamataban jatszanak szerepet.

Itt torténik a dokumentumok leforditasa és ellendrzése.

Itt hozhat létre és kezelhet forditasi memoariakat.

Projektmenedzsment - Elsé l1épések utmutaté
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Offline Projekt munkafolyamat projektcsomag esetén

Az SDL Trados Studio lehet6vé teszi, hogy a sajat igényeinek megfelelé munkafolyamatot
hasznalhassa. A kdvetkezé diagram egy tipikus munkafolyamatot mutat be, ha az SDL Trados

Studio-ban projektekkel és projektcsomagokkal dolgozik.

MEGJEGYZES

Az SDL Studio GroupShare Project szerver segitségével végzett egyfelhasznélés on-line
munkafolyamatokrél az SDL Trados Studio Sugé vidediban és leirasaiban talal

informaciot.
( z o )
Projektvezetd
N
Beallitasok és
erdforrasok ;
megadasa Fé]loif »
(Tools > véglegesitése
Options)
Projekt
létrehozasa
Projektcsomag Projektcsomag
létrehozésa megnyitasa
| —
. J
Projektcsomag Visszakuldendd
kikuldese csomag elkildése
L
v ™
[i I Fordité
Projektcsomag V'ssé{:;rt::gsndo
megnyitasa létrehozasa
Fajlok
forditasa
> Projektcsomag Projektcsomag
létrehozasa megnyitésa
4
\.
Projektcsomag Visszakildendd
kikuldése csomag elkuldése
l
i e R
VISSZAUTASITVA: Lektor
Visszakuldve
a forditonak javitasra ; A &
Projektcsomag Visszakuldendd
¥ csomag
megnyitasa létrehozasa
Fajlok — L_ JOVAHAGYVA
l lektoralasa
. J
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Alapértelmezett nyelvpar-beallitasok

Nyelvpdrok

Adott forrasnyelvrél adott célnyelvre torténé forditas esetén azok bedllitasait nyelvparok
(language pair) téroljak. Az eréforrasok és bedllitasok ugy lettek kialakitva, hogy az 6sszes olyan
nyelvpar esetében alkalmazhatok legyenek, melyekre vonatkoznak. A tobbnyelvi eréforrasok,
mint a terminoldgiai adatbazisok és a szerveralapu forditasi memoéridk tobb nyelvparra is
vonatkozhatnak. A kétnyelv( eréforrasok, mint a fajlalapu forditasi memariak, csak egy adott
nyelvparra vonatkoznak.

Miel6tt projektet hozna létre vagy dokumentumot forditana, allitsa be a nyelvpérra vonatkozé
alapértelmezett bedllitasokat. Ezaltal minden egyes forditasi projekthez ugyanazokat a
beallitdsokat és eréforrasokat alkalmazhatja.

Példaul, ha mindig angol-német nyelvparban kap forditasi projekteket, akkor beallithatja, hogy
ebben az esetben a program melyik forditdsi memdridt, terminolégiai adatbazist vagy egyéb
eréforrdsokat haszndlja.

Options (Bedllitdsok) parbeszédablak

A forditési projektek alapértelmezett bedllitdsait az Options (Beallitasok) parbeszédablakban
adhatja meg. Amikor itt megadja az adatokat, akkor az alapértelmezett projektsablon
automatikusan frissul. Ezt a projekt |étrehozasandl ki is valaszthatja. A program az
alapértelmezett projektsablont a kdvetkezé helyen tarolja:

...Documents\Studio 201 1\Projects\Samples\Project Templates\Default.sdltpl
(b Az olyan ugyfeleknek, akiknek tobb projektet is kell készitenie, projektsablonok

Tipp hasznalataval is meghatarozhatja a beallitadsokat. Sablon készitéséhez valassza ki a
Project > Create Project Template (Projekt > Projektsablon létrehozasa) menupontot.

Projektmenedzsment - Elsé l1épések utmutaté
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Osszes %, Editor Translation Memory and Automated Translation
nye|vpa’r ¥ A!.ltoSuggest B Select translation memory and automated translation servers to apply to All Language
fﬁ File Types =~ Pairs and specify whether to include them in lookup, concordance search and whetherto
53 Verification ' N
NGB Language Pairs o Add - G Create ~ | [ Settings... | & 3 remove ]:_ Import...
C-mp All Language Pairs
ER E] Translation Memory and Automate MName Enabled | Lockup Penalty Concordance Update
Search i}TM'I 0
.. Penalties f English-German sdltm ] O
Egyenl Filters
nyelvparok Update
Language Resources
\ ! Termbases

Osszes nyelvpdr (All Language Pairs)

Altalaban az All Language Pairs (Osszes nyelvpar) szinten &llithatja be a forditasi eré6forrasokat
(még ha kétnyelviek is), és ugyanitt médosithatja a bedllitdsokat. A beallitdsok igy minden
nyelvparra, a forditasi eréforrasok pedig az dsszes relevans nyelvparra vonatkoznak.

Példaul:

e Ha az All Language Pairs (Osszes nyelvpar) szinten olyan tobbnyelv(, szerveralapu
forditasi memoriat valaszt, amely tartalmazza az angol-német és angol-francia
nyelvparokat, akkor ezt a forditasi memdoriat a program automatikusan kivalasztja
minden angol-német és angol-francia projekt esetén.

e Ha az All Language Pairs (Osszes nyelvpar) szinten 65%-ra médositja a minimum
egyezési értéket, akkor az minden nyelvparra érvényes lesz.

@Tipp Minden egyes nyelvpar bedllitdsaihoz adhat egyéni kivételeket. Példaul, ha meg
akarja valtoztatni az angol-német nyelvpar minimum egyezési értékét, akkor azt az
adott nyelvpar szintjén teheti meg.

N [&n Batch Processing
& English (United States)->German (Ger Language Pairs Using Different Translation Providers
B English (United States)->French (Franc]  The following language pairs do not use the translation providers listed under All Language Pairs.

4 Default Task Sequence Review the list as required.
f Translation Memories View Name Enabled  Lookup Penalty Concordance | Upda
&' Colors

< Keyboard Shortcuts
2 Lutomatic Updates
& Home \iew

£ >

] (o) (s
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Eréforrasok

Egy nyelvparhoz a kdvetkezd eréforrdsokat valaszthatja ki:

Eroforras Leiras

Az SDL Trados Studio fajlalapu forditasi memoria fajlformatuma az .sdltm.
Hasznélhat SDL Trados Studio 2009 és 2011 barmely verziéjaban létrehozott
forditasi memoridkat egyarant. Ha korabbi SDL Trados vagy SDLX verzidban
létrehozott forditasi memdériaval rendelkezik, akkor azokra vonatkozo
tovabbi informéaciét az SDL Trados Studio 2011 SP2 Adatmigrdcios

r\:’;:\l;:isa!k utmutatéban talal. Ott megtudhatja, hogyan frissitse forditasi memoridjat a
jelenlegi formatumra.
Szerveralapu forditdsi memoridkhoz is kapcsolédhat az SDL TM Server 2009
SP3,az SDL TM Server 2011 és az SDL WorldServer 2011 (10.1 és 10.2-es
verzid) szerververziokon keresztul.
Az automatizélt (gépi) fordités olyan forditast takar, amelyet emberi
beavatkozas nélkl, szamitogépes szoftver végez. Az automatizalt forditast
biztosité alkalmazés egy szerverre van telepitve, melyhez a szerveralapu
forditasi memoridhoz hasonldan férhet hozza. A kovetkezé automatizalt

Automatizalt forditasi szerverekhez férhet hozza:

g::;)etordltaﬂ e az SDL alapértelmezett automatizalt forditasi szervere

e SDL BeGlobal
e Google Translate

Tovabba hozzaadhatja sajat testreszabott automatizalt forditasi szerverét is.
Az SDL Trados Studio 2011 SP2 az SDL MultiTerm 2009 és 2011 SP2-ben
[étrehozott (.sdltb kiterjesztés() fajlalapu terminolégiai adatbazisokat
hasznal. Tovabba a kdvetkezé kordbbi terminolégiai adatbazis formatumokat
hasznalhatja:

Terminolégiai e SDL MultiTerm 2007 (7.5 verzid) és régebbi 7.x kiadasok

adatbazisok e SDL MultiTerm iX (6.x verzid)

Ha megnyitja a régebbi verziéju terminoldgiai adatbazisokat, azok
automatikusan frisstlnek SDL MultiTerm 2011 SP2 (.sdltb) formatumma.

A MultiTerm Server 2009 SP3 és a MultiTerm Server 2011-en keresztil is
csatlakozhat szerveralapu terminolégiai adatbézisokhoz.

Az AutoSuggest funkcié egy fontos Uj elem, amely felgyorsithatja a manualis
forditast. Az AutoSuggest funkcio figyelemmel kiséri az On altal begépelt
szavakat és néhdny karakter begépelése utén a forditasi memoridbdl olyan
szavakat, mondatokat javasol célnyelven, melyek ugyanazzal a karakterekkel
kezdédnek. A kdvetkezéket hasznélhatja az AutoSuggest eréforrasaként:

AutoSuggest e AutoSuggest szotdrak - hozzon létre egy Ujat vagy vélasszon ki egy

szoétarak korabbi AutoSuggest szétarat, melyet On vagy egy masik
felhasznald hozott létre. Ez a szdtar forditasi memaoriakbdl (.sdltm)
vagy .tmx fajlokbdl kivonatolt szavakat és mondatokat tartalmaz.

e A projekthez hozzarendelt SDL MultiTerm terminoldgiai adatbazis.

e AutoText bejegyzések - az SDL Trados Studio-ba valé begépeléssel
sajat kez(leg is |étrehozhat egy sz6- és mondat listat.

Projektmenedzsment - Elsé l1épések utmutaté
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Az alapértelmezett nyelvpdr-bedllitasok meghatdrozdsa

esetében az alapértelmezett forditasi memoriak, terminoldgiai adatbazisok és AutoSuggest
szotérak bedllitdsdhoz kdvesse az aldbbi utasitdsokat.

MEGJEGYZES Ezeket a beallitasokat az All Language Pairs (Osszes nyelvpar) szint
megfeleld helyén kell elvégezni.

Egyéb nyelvpérok alapértelmezett eréforrasainak bedllitdsdhoz ugyanezt az eljarast kdvetheti.
Ebben a példdban az SDL Trados Studio mintaprojektjét fogja haszndlni. Ha mér otthonosan
mozog a lépések kozott, akkor arra hasznalhatja azokat, hogy meghatéarozza sajat
alapértelmezett eréforrasait, amelyek az On altal alkalmazott valamennyi nyelvparra
vonatkoznak majd.

1. Valassza a Tools > Options (Eszk6z6k > Beallitasok) menlipontot a menilsavban. Az Options
(Beallitasok) parbeszédablak jelenik meg.

2. Vdlassza ki a Language Pairs > All Language Pairs > Translation Memory and Automated
Translation (Nyelvparok > Osszes nyelvpar > Forditasi meméria és automatizalt forditas)
szintet a navigacios panelben.

3. ATranslation Memory and Automated Translation (Forditasi memoria és automatizalt
forditas) oldalon valaszthatja ki a fajlalapu és szerveralapu forditasi memoriakat. Valassza ki
az English-German.sdltm minta forditasi memoriat.

! ...Documents\Studio 201 1\Projects\Samples\SampleProject\
TMs\English-German.sdltm

e Haa program az angol (egyestilt dllamokbeli) - német (németorszdgi) nyelvpérra
vonatkozéan nem tartalmaz alapértelmezett beallitdsokat, akkor az Add Supported
Language Pairs (Tamogatott nyelvparok hozzaadasa) parbeszédablak jelenik meg.
Pipdlja be az Uj nyelvpar elétti jelolénégyzetet, majd kattintson az OK gombra.

Add Supported Language Pairs

This translation memory supparts some language pairs that are nat in this project or project
template. Select the supported language pairs to add to this project or project template.

Select All
English (United States) | German (Germany)
v Unzelect Al

Source Language Target Language

Ok l[ Cancel ] ’ Help

Projektmenedzsment - Elsé l1épések utmutaté
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Vélassza ki a Language Pairs > All Language Pairs > Termbases (Nyelvparok > Osszes nyelvpar
> Terminolégiai adatbazisok) opciot a navigacios ablakban.

A Termbases (Terminolégiai adatbazisok) oldalon vélaszthatja ki az SDL MultiTerm
terminoldgiai adatbazisokat. Valassza ki a Printer.sdItb minta terminolégiai adatbazist.

! ...Documents\Studio 201 1\Projects\Samples\SampleProject\ Termbase\Printer.sdltb

6.

< Editor
# AutoSuggest
=2 File Types
Verification
= Language Pairs
=-mp All Language Pairs
]’ Translation Memory and Automat
[% Batch Processing
=R
Search Settings
B> English (United States)->German (G
]’ Translation Memories View
@ Colors
< Keyboard Shortcuts
3 Automatic Updates
) Home View

£ >

Reset to Defaults

Tembases

1 I Add termbases to the project and order them. Set a default termbase and choose the index to
use for each language.

Tembases:
Enabled Termbase Filter
] Printer Termbase (defaulf) % | (Not specified)

[ Add... ] [ Remove

Indexes:

Project Language Index
= English (United States) English
= German (Germany) German

I OK l[ Cancel ][ Help

Vélassza ki a Language Pairs > English (United States)->German (Germany) > AutoSuggest
Dictionaries (Nyelvparok > Angol (egyesiilt allamokbeli)- Német (németorszagi) >
AutoSuggest szétarak) opciét a navigaciés ablakban.

MEGJEGYZES

AutoSuggest szétarakat csak az egyéni nyelvpar szinteken éllithat be.

Projektmenedzsment - Elsé l1épések utmutaté
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7. Az AutoSuggest Dictionaries (AutoSuggest szétarak) oldalon valaszthatja ki az AutoSuggest
szotarakat. Valassza ki az AutoSuggest_EN-US_DE-DE.bpm minta AutoSuggest szotart.

! ...Documents\Studio 201 1\Projects\Samples\SampleProject\ AutoSuggest\AutoSuggest_EN-
US_DE-DE.bpm

%, Editor AutoSuggest Dictionaries

P AutoSuggest This page lists the AutoSuggest dictionaries. Use the Add and Remove buttons to add
_é File Types Q and remove AutoSuggest dictionaries. Use the Generate button to generate

5 Verification AutoSuggest dictionaries.

=-[ Lsnguage Pairs
B Al Language Pairs
== English (United States)->German (Ger
f Translation Memory and Automate
[Z7 Batch Processing
.
f Translation Memories View
€ Colors
== Keyboard Shortcuts
2 Automatic Updates
& Home View

Name

| AutoSuggest EN-US_DE-DE

< > i Crome

QK ][ Cancel ][ Help ]

8. Azalapértelmezett bedllitisok elmentéséhez kattintson az OK gombra.

Mostantdl a program ezeket az alapértelmezett eréforrdsokat haszndlja minden egyes
alkalommal, mikor a projektsablon hasznalataval Gj angol-német forditési projektet hoz létre.

(b Az All Language Pairs (Osszes nyelvpar) rész alatt tovabbi beallitdsokat adhat meg,

Tipp mint példaul a minimum részleges egyezés (fuzzy match) értékeket és az
automatikus helyettesitést. Ne felejtse el, hogy ezek a beallitasok az 6sszes
nyelvpdrra vonatkoznak majd. Ha csak az angol-német nyelvparra vonatkozé
bedllitasokat szeretné megadni, akkor azt a Language Pairs > English United States)
-> German (Germany) rész alatt teheti meg.
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Projektkoncepcidk

Miel6tt étrehoz egy Uj projektet, nézze at az alabbi projektkoncepcidkat.

Koncepcioé

Nyelvparok

Projekt

Projektcsomag

Visszakiildendé
csomagok

Leiras

Egy forrdsnyelv és egy célnyelv (az a nyelv, amelyre fordit). Néhany eréforrdsok és
bedllitds, mint példaul a tobbnyelvi terminoldgiai adatbazisok az 6sszes nyelvparra
alkalmazhaték. A forditasi memoéridk és az AutoSuggest szétarak csak egy adott
nyelvpdrra alkalmazhaték, mivel kétnyelviiek. Azonban meghatarozhat olyan
forditasi memdria bedllitast, amely minden nyelvparra érvényes lesz. Példaul az All
Language Pairs (Osszes nyelvpdr) szinten 70%-ra médosithatja a részleges egyezés
minimum értékét. Valamennyi nyelvparhoz kivalasztott forditasi memoriara érvényes
lesz ez a bedllitas.

Az 6sszes féjlt egy projekt részeként forditja és kezeli a program. A projekt egy vagy
tobb forditandé fajlt is tartalmazhat, amiket egy vagy tobb nyelvre kell leforditani.
Tovabba tartalmazhat referenciaanyagokat, forditadsi memoridkat, terminolégiai
adatbazisokat, AutoSuggest szétarakat és utasitasokat a forditdk szamara.

Egy projekt Iétrehozdsa utdn a projektvezet6 az SDL Trados Studio
projektmenedzsment eszkdzok segitségével kezelheti a projekt valamennyi fazisat,
valamint ellenérizheti a projekt el6rehaladésat.

A projektcsomag egy olyan fajlszerkezet, amely tartalmazza a projekt forditdsdban
résztvevé forditoknak elkiildendé 6sszes fjlt. Ez4altal a forditok elkezdhetnek
dolgozni a fajlokon. Példaul dolgozhatnak a forditandé vagy ellenérizendé fajlokon.

Amint létrehozta a csomagot, elkiildheti azt e-mailben, feltoltheti FTP oldalra vagy
hasznéalhat barmely més preferalt médszert, hogy elkildje annak a csapattagnak, aki
a projekten dolgozni fog. igy nem kell tébb fajlt vagy tébb e-mailt kiildenie, tovabba
a projekttel kapcsolatos informécidkat a projektfajlokkal egyutt egy logikus
szerkezetben kiildheti el.

A visszakildendé csomag (return package) olyan projektfdjlokat tartalmaz, melyeken
egy bizonyos manudlis feladatot hajtottak végre. llyenek példaul a leforditott vagy
ellenérzott projektfajlok. Tartalmazhat azonban olyan féjlokat is, melyek tovabbi
munkélatokat igényelnek. Példaul az ellenérzést végzé személy visszakiildheti a
leforditott fajlt, mert forditasi hiba van benne, amit a forditénak kell kijavitania.

Amikor egy visszakiildendé csomagot hoz létre, az csak a projektfajlokat tartalmazza,
a forditasi memoriat, terminoldgiai adatbazist és az AutoSuggest szétarakat nem.
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PerfectMatch
(Tokéletes
egyezés)

Kotegelt
miiveletek

Miivelet
szekvencia

A PerfectMatch (tokéletes egyezés) olyan szovegkornyezeti egyezés, amely a frissitett
forrasnyelvi fajlokat a megfeleld kétnyelvli dokumentumokkal veti 6ssze, nem pedig
a forditasi memariaval. A szegmensegyezések, azaz PerfectMatch-ek (tokéletes
egyezések) esetében a szovegkornyezet is ellenérzésre kerilil annak biztositésa
érdekében, hogy valéban ugyanaz legyen a két szegmens. Ezek aztdn a mar meglévé
kétnyelvli dokumentumokbdl a frissitett forrasfajlokba kerlinek. Mivel a
PerfectMatch (t6kéletes egyezés) szegmensek keresési folyamatanak része a
szovegkornyezet ellenérzése, a PerfectMatch egységek altaldban mar nem
igényelnek tovabbi forditast vagy szerkesztést.

A muvelet egy olyan folyamat, melyet egy 6nallé fajlon vagy egy fajlcsoporton (pl.
egy egész projekten) hajthat végre. A kotegelt muiveleteket a rendszer végzi el.
Példaul a Word Count (Szészamlalé) kotegelt mivelet szoszamlalast végez a
kivalasztott fajlokon. Az eredmények az SDL Trados Studio Reports (Jelentések)
nézetében taldlhaték. A kotegelt miveletek sorrendbe allithatok. A szekvencidban
szerepld valamennyi m(iveletet végrehajtja a program a kivalasztott fajlokon (olyan
sorrendben, ahogy azok a megadott szekvencidban szerepelnek).

Egy mUvelet szekvencia tobb kotegelt mUveletet tartalmaz. Amikor lefuttat egy
mdvelet szekvencidt, akkor a szekvencidban szereplé 0sszes mlveletet lefuttatja a
kivélasztott fajlokon: a program olyan sorrendben hatja végre a mveleteket, amilyen
sorrendben a szekvencidban szerepelnek. Szamos kotegelt mivelet szekvencia all
rendelkezésére, és ha Professional verzidval rendelkezik, akkor Ujat is hozhat Iétre.
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Projektek létrehozasa

Tegyiik fel, hogy az tigyfél (SDL) arra kérte Ont, hogy forditson le néhany fajlt angolrél németre.
El6szor is a New Project (Uj projekt) varazslé segitségével hozzon létre egy projektet. Ezaltal:

)

Tipp

forditasi elemzést végez, az adatokat az SDL Trados Studio-ban és az SDL Trados
Studio jelentések nézetében tekintheti meg;

konvertalja a projektfajlokat SDLXLIFF formatummé;
a forditasi memoéridban szerepl6 forditasok alkalmazasaval eléforditja a projektfajlokat;

létrehozhat egy fajlalapu projekt forditasi memoériat, amely a projektfajlokkal egyitt
elkuldheté.

Ha Ugy dont, hogy a projekt [étrehozasakor nem futatja le valamelyik mUveletet,
akkor azt a projekt [étrehozésa utan is megteheti. Példaul, lehet, hogy csak azért
kivanja elemezi projekt létrehozas kdzben a fajlokat, hogy az igy kapott
eredmények segitségével drajanlatot allitson ki az igyfélnek.

Projekt létrehozdsa

1. Barmely nézetben kattintson a Standard eszkoztarban taldlhatd New Project (Uj projekt)
gombra. A New Project (Uj projekt) varazslé Project Type (Projekttipus) oldala jelenik meg.

Ezen az oldalon, ha nincs kivélasztva, valassza ki a Create a project based on project

template (Projekt létrehozasa projektsablon alapjan) opciét, majd a legordilé listabdl
valassza ki a Default (Alapértelmezett) (Default.sdltpl) sablont. Ezzel kivélasztja az
alapértelmezett projektsablont, amely az Options (Beallitasok) parbeszédablakban
megadott alapértelmezett bedllitdsokkal és forrdsokkal frissiilt.

! i ...Documents\Studio 201 1\Projects\Samples\Project Templates\Default.sdtlpl

o

New Project Q@l E|

Project Type .
Speciy whather to create a project based on a project template or whetherto create 3 project based on a W
previous project.

(®) Create a project based on a project template

(O Create a project based on a pravious project

Kattintson a Next (Tovabb) gombra.
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A projekt alapadatainak megadasa

4.

)

A Project Details (Projekt részletek) oldal jelenik meg. Adja meg a kdvetkezé
bedllitdsokat:

e Name (Név): Sample EN-DE

e Location (Hely): A program a projektet automatikusan a Documents\Studio
2011\Projects mappdaba menti. Ne médositsa az alapértelmezett helyet.

e Kattintson a Customers (Ugyfelek) gombra és hozza létre az SDL-t, mint Ugyfelet.
Ezutén vélassza ki az SDL-t a Customer (Ugyfél) legordlé listabol.

A Publish project on GroupShare opciéval on-line is kdozzéteheti a projektet a

Tipp forditasban résztvevé forditok szamara. Ezaltal a projekt a Project szerverre keriil

(SDL Studio GroupShare). Erre vonatkozé informaciét az SDL Trados Studio Sugd
vidediban és leirasaiban talal.

New Project

Project Details Rl
Flease specify a project name and location, and optionally specify a project description, number, customer and W
due date.

MName: Sample EN-DE

Description:

Location: C::\Documents and Settings*Administrator. My Documents®Studio 2011%Projects'.Sample EN

Publish project on GroupShare

Server: http://projectserverl2/ w

About SOL Studio GroupShare...

Due Date: [ ]

Customer: SDL w
oo ) (e ]

Kattintson a Next (Tovabb) gombra. A Project Languages (Projekt nyelvek) oldal jelenik meg.
Ezen az oldalon vélassza ki forrdsnyelvnek az English (United States), azaz angol (egyesult
allamokbeli)-t, célnyelvnek pedig a German (Germany), azaz német (németorszagi)-t.

MEGJEGYZES  Tobb céinyelvet is valaszthat egy projekthez.

6.

Kattintson a Next (Tovabb) gombra.
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Projektfajlok kivalasztasa

7. A ProjectFiles (Projektfajlok) oldal jelenik meg. Ezen az oldalon vélassza ki a forditando
fajlokat:

e Kattintson az Add Files (Fajlok hozzaadasa) gombra, majd valassza ki a harom
mintadokumentumot.

! E ...Documents\Studio 201 1\Projects\Samples\SampleProject\en-US:
e  SamplePhotoPrinter.doc
o e  SamplePresentation.pptx
e  SecondSample.docx

New Project E| |§| E|

Project Files P

Add project files or folders and verfy that all file types are comectly identfied. @

[& Add Files... gl Add Folder... {l New Folder... | »

L_J>ample EN-DE [&) MName Size Type Usage Fi

IEI] SamplePhotoPrinter. doc 31 KB Microsoft Word.. Tranzlatable Wo

hﬂ] SamplePresentation pphe 48 KB Micrescft Pow_.  Translatable Pow

E:" SecondSample.docx 21 KB Microsoft Word.. Transzlatable Wo

< >

Translatable: 2 Reference: 0

[ < Back ] [ Mead > ] [ Finish ] [ Cancel ]

A hozzéadott fajlokat a program ellendrzi és meghatérozza azok tipusat, tovabba kivalasztja a
megfeleld fajltipus beallitasokat.

e A Usage (Hasznalat) oszlop jelzi, hogy harom mintafajl Translatable (Fordithaté). A
Change File Usage (Fajl hasznalat médositasa) gombra kattintva hatdrozhatja meg a
haszndlat tipusat. Itt dllithatja be azt, ha bizonyos fajlokat referenciaféjlokként szeretne
kezelni.

o Afdjl feldolgozasakor hasznalt fajlsz(iré a Type (Tipus) oszlopban lathaté. A File Types
(Fajltipusok) gombra kattintva tekintheti meg vagy mddosithatja a fajlsz(ird
bedllitdsokat.

8. Kattintson a Next (Tovabb) gombra.

Projektmenedzsment - Elsé l1épések utmutaté
17. oldal



0.

Forditasi memoriak kivalasztasa

A Translation Memory and Automated Translation (Forditasi meméria és automatizalt forditas)
oldal jelenik meg. Az alapértelmezett beallitdisok meghatarozasakor kivalasztott forditasi
memdéridt a program most automatikusan hozzéadja a projekthez.

! i ...Documents\SDL Trados Studio\Projects\Samples\SampleProject\

o

TMs\English-German.sdltm

MEGJEGYZES  Tgbb forditasi memariat is hozzaadhat a projekthez, valamint csatlakozhat
automatizalt (gépi) forditasi szerverekhez is.

New Project

Translation Memory and Automated Translation
Select translation memores and automated translation servers for the language pairs selected in the project.

== All Language Pairs
= f Translation Memory and Auto

Search
Penalties
Filters
Update
Language Resources

B English (United States)->German

Translation Memory and Automated Translation

= Select translation memories and automated translation servers and
| specify whether to include them in look-up, concordance search and
= whether to update them:

of Add ~ LJa Create - ?
Name Enabled Lookup Pensalty Concordance Update
B English (United States)->German (Germany)

§ English-G.. 0

< Back H Mext H Finish ] [ Cancel

Kattintson a Next (Tovabb) gombra.
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Terminoldgiai adatbazisok kivalasztasa

A Termbases (Terminolégiai adatbazisok) oldal jelenik meg. Az alapértelmezett beallitdsok

meghatarozasakor kivalasztott terminolégiai adatbazist a program most automatikusan
hozzdadja a projekthez.

! i ...Documents\SDL Trados Studio\Projects\Samples\SampleProject\ Termbase\Printer.sdltb
O

MEGJEGYZES  Tsbb terminoldgiai adatbazist is hozzdadhat a projekthez.

New Project ['Z| |§|gl
Termbases |

T
Add termbases to the project and order them. Set a default termbase and choose the index to use for each w
language.

Temnbases:
Enabled Termbase Filter
: Printer Termbase (default) %@ | (Not specified)

Add... ] [ Remove

Indexes:

Project Language Indesx
% English (United States) Englizh
== German (Germany) German

< Back ] [ Mext l [ Finish

] [ Cancel

10. Kattintson a Next (Tovabb) gombra.

Projektmenedzsment - Elsé l1épések utmutaté
19. oldal



Uj

projektféjlok/

A PerfectMatch (Tokéletes egyezés) alkalmazasa korabban leforditott
dokumentumok Gjra felhasznalasaval

Az SDL PerfectMatch (SDL tékéletes egyezés) oldal jelenik meg. Ezen az oldalon vélaszthatja ki a
PerfectMatch (Tokéletes egyezés) funkcidhoz hasznalandé korabban leforditott
dokumentumokat. Ennek segitségével korabbi kétnyelvi SDLXLIFF, SDL Edit (ITD) vagy
TradosTag (TTX) dokumentumok forditasait helyezheti at az Uj projektfajlokba.

MEGJEGYZES Az On SDL Trados Studio licenctipusatél fiiggéen ez a funkcié hidnyozhat. Licenccel
kapcsolatos informacidkért 1asd az About Editions and Licensing fejezetet az SDL Trados

Studio Sugdban.

Mikor haszndlja a PerfectMatch (Tokéletes eqyezés) funkciét?

Korabbi forditasait két médon hasznalhatja fel a PerfectMatch (Tokéletes egyezés)
alkalmazaséaval. Tovéabbi mddszereket az SDL Trados Studio Sugdban talal.

El6z6 projekt ,forgatékényv”

Egy mér |étezd, teljesen leellendrzott projekt alapjan is hozhat létre egy Uj projektet. Ekkor a
program a PerfectMatch (Tokéletes egyezés) funkcid alkalmazasaval az el6z6 projekt
leforditott dokumentumait hasznalja fel.

Ez kiilondsen akkor hasznos, ha példaul egy termék mésodik verzidjdnak muszaki
kézikonyvének forditasaba kezd, és ez a termék szinte teljesen megegyezik az elsé verzidval.

Projekt kbzbeni ,forgatékényv”

Ha mar leforditotta a projekt egy részét és Uj forrasnyelvi fajlokat kap, melyeken apré
valtoztatasokat hajtottak végre, akkor a PerfectMatch funkcio segitségével jovahagyhatja az
eddig elvégzett munkét az Uj dokumentumokon.

Ezt ugy teheti meg, hogy az éppen forditott dokumentum alapjan létrehoz az Uj fajlokkal egy
Uj projektet. Ekkor a PerfectMatch funkcié automatikusan jévahagyja az eddig elvégzett
munkat az uj fajlokon.

New Project E| |§| Fz|
SDL PerfectMatch

L
Add a previously translated bilingual documert for each translatable file in the project, and then choose what @
translation origin and status to use for the transfermed translations.

[& Add = ] Remove ~ | T(d

_Ferman (Germary [EERR| RS Provious Docurment
/ fEI SamplePhotoPrinter. doc SamplePhotoPrinter.doc.sdlxiff
T £xl] SamplePresentation.pptx .
" SecondSample.docx ™~ Korabban
|~ leforditott
dokumentumok
¢ >

Translation transfer options:
& Apply PerfectMatch and lock

{7 Use the original translation origin and status

< Back H Mext > H Finish ] [ Cancel
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Uj tartalom a 2.
verzidban

Tegylk fel, hogy a SamplePhotoPrinter.doc fajlnak van egy 1.verziéja, amit mar az el6z6
projektben teljesen leforditott és leellenérzott.

SamplePhotoPrinter-Version1.doc

SamplePhotoPrinter.doc.sdlxliff [Translation] v X
Allow encugh space on all sides of the 1y Lassen Sie gendgend Abstand zu FN+ ﬂ
photo printer to let you connect and allen Seiten des Eotodruckers.
disconnect cables, change the color damit Sie jederzeit Kabel verbinden
cartridge, and add paper. und trennen, die Farbpatrone
auswechseln bzw. Papier
hinzufiigen kénnen. Az 6sszes
. Connecting and turning % Verbinden und szegmens le
on the power Anschliefen lett forditva
2| Note: 1, Hinweis: P és ellenérizve.

INS [ 0.00% {bu.lmi 1 100.00% |7 Chars: 77 B

A jelenlegi projektben ennek a dokumentumnak a 2. verziéjat vélasztotta, ami tartalmaz
néhany kiegészitést.

SamplePhotoPrinter-Version2.doc

SamplePhotoPrinter-VersionZ doc [Translation en-US-de-DE] v X
Allow enough space on all sides of the E P+
photo printer to let you connect and
disconnect cables. change the color
cadridge and add paner

This is a new sentence. : LT
5 wonnectng and turning B
on the power
10 Note: ] P
_ Use only the AC power adapter B b

Mivel a dokumentum majdnem teljesen megegyezik az el6zével, igy az el6z6 dokumentum
forditasait PerfectMatch-ként (Tokéletes egyezésként) atlltetheti a dokumentum Gj verziéjaba.

11. PerfectMatch (Tokéletes egyezés) alkalmazasahoz valassza ki az el6z6 dokumentumot az
SDL PerfectMatch oldalon.

e Kattintson az Add (Hozzaadas) gombra, majd a listabdl valassza ki a Specific Previous
Document (Adott korabbi dokumentum) opciét.

e Valassza ki a dokumentum kordbban leforditott verzidjat.

! i A mintafajl kordbban leforditott verzidja nem tartozik a Studio mintafajlok kozé.
Azonban a kdvetkezé oldalon lathatja a PerfectMatch funkcié eredményeit.
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Mivel az el6z6 dokumentum teljesen le lett forditva és ellenérizve, az Uj projektfajlba atvitt
szegmensek nem igényelnek tovabbi forditast vagy ellendrzést.

12. Ahhoz, hogy jelezze, hogy az athelyezett forditds nem igényel tovdbbi munkat, valassza az
Apply PerfectMatch and lock (Tokéletes egyezés alkalmazasa és zarolasa) opciot.

Translation transfer options:
(3 Apply PerfectMatch and lock

(O Use the original translation origin and status

Ezéltal a program az Gsszes forditast athelyezi az Uj dokumentumba, és a Segment Status
(Szegmens allapot) oszlopban a kovetkez6 jelenik meg:

. l:] - Jelzi, hogy az egyezés tipusa PerfectMatch (Tokéletes egyezés).

o Iz Jelzi, hogy a szegmens allapota Signed off (Végleg jovahagyott). Ez azt jelenti,
hogy a szegmensek nem igényelnek tovabbi forditast vagy attekintést.

o -Jelz, hogy a program zarolta a forditasokat. Mivel tovabbi feladat nincs velik, a
program ezdltal megdvja a szegmenseket a véletlenszer( szerkesztéstél.

l i Az eredmények megtekintéséhez nyissa meg Editor (Szerkeszt8) nézetben a
Sample Project TryPerfectMatch.doc.xliff nev fajljat.

PerfectMatch funkcid alkalmazdsdnak eredményei

Tokéletes egyezések a Szegmens allapot oszlopban.

A leforditasra ?En'|:-IsF:I':-t:-F'rirtsr-"—."srsi:-rE.:-:::.scl:t.Iiﬁ [Translation] . ; . . - v X
e cartridge, and add paper ennen, die Farbpatrone ”
varo uj In bzw. Papier
tartalom \ hinzufigen kénnen
This is a new sentence. [ LI A dokumentum
: o .
.| connecting and turning ¥ q Verbinden und |97t't7f7fj?tmaf le
. ettroraitva es
on the power Anschliefen cllendrizve
10| Note M 4| Hinweis ’
Use only the AC power adapter ol Verwenden Sie ausschlieflich
includad sarith wnore nhatn nrintor Aae Mlotrtail das ios %
INS [1223% {50009 3597, > Chars: 0 B

13. Lépjen vissza a New Project (Uj projekt) varazsloba és az SDL PerfectMatch (SDL Tokéletes
egyezés) oldalon kattintson a Next (Tovabb) gombra.
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Miveletek és azok beallitasainak kivalasztasa

A Project Preparation (Projekt el6készités) oldal jelenik meg. Ezen az oldalon vélaszthatja ki az
el6készités |épéseit, melyeket az Gjonnan létrehozott projekt fajljain végre akar hajtani. A
mUvelet szekvencia olyan kotegelt miveleteket tartalmaz, amelyek elékészitik a projektfajlokat.
Tovébbi informaciokért lasd a Kétegelt miveletek fejezetet.

Alapértelmezett miivelet szekvencia

Attél fuggben, hogy melyik SDL Trados Studio verziot haszndlja, az alapértelmezett muivelet
szekvencia kilonbozik:

e  Prepare (El6készités)
e Prepare without Project TM (El6készités projekt forditdsi memdcria nélkiil)

Mindkét mlivelet szekvencia ugy késziti el6 a fajlokat forditasra, hogy kétnyelvi sdixliff
formatumma konvertalja, el6forditja és elemzi azokat. A ketté kozott annyi a kiilonbség, hogy a
Prepare without Project TM (El6készités projekt forditdsi memdria nélkiil) szekvencia nem hoz létre
projekt forditadsi memoriat.

MEGJEGYZES A projekt forditasi memoria olyan forditasokat tartalmaz, melyek az On altal
kivalasztott f6 forditasi memoriakbdl szarmaznak. Csak olyan forditasok keriilnek a
projekt forditasi memdridba, melyek egyezési mértéke eléri az elé6re meghatérozott
minimum egyezési értéket.

Mikor haszndlja a Prepare (Elékészités) mivelet szekvencidt?

Ha nem akarja, hogy forditas soran a forditok frissitsék a fé forditasi memariat, ugyanakkor
engedélyezni szeretné, hogy a forditdk felhasznalhassak az altaluk vagy a projekten dolgozé
mas forditdk altal mar leforditott szegmenseket, akkor ezt a muvelet szekvenciat érdemes
hasznélnia.

Mikor haszndlja a Prepare without Project TM (El6készités projekt forditdsi meméria nélkiil)
muvelet szekvencidt?

Ha On szabaduszé fordité és forditas soran a projekt forditasi memoria helyett a f6 forditasi
memoriat szeretné frissiteni, akkor ezt a mUvelet szekvenciat érdemes hasznélnia, mivel ez nem
hoz létre projekt forditasi memoriat.
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Prepare Project Preparation
(EIGkészités) Select a predefined task sequence to run as part of project creation, or create a custom task sequence. W
mivelet
szekvencia \ITask Sequence: |Prepare I .’ | l Task Sequences... ]
Details
K('jtegelt Description:
muvelete Convert, analyze and pre4ranslate files.|
a Prepare
(El6készités) Batch Tasks:
muvelet Convert to Translatable Format

szekvencidban

Copyto Target Languages

Apply PedectMatch

Analyze Files

Pre4ranslate Files

Populate Project Translation Memories

[ < Back ][ Mexd = ][ Finish ] [ Cancel ]

14. Szlikség esetén valassza ki a Task Sequence (Miivelet szekvencia) legordilé listabdl a
Prepare (El6készités) mUvelet szekvenciat, majd kattintson a Next (Tovabb) gombra.

A Batch Processing Settings (K6tegelt miiveletek futtatasanak beallitasai) oldal jelenik meg. Ezen
az oldalon hatarozhatja meg a kotegelt mUiveletek futtatasanak beallitasait. Ezek a bedllitasok a
Project Preparation (Projekt el6készités) oldalon kivalasztott mdveletek futtatasa soran
érvényesilnek.

A rendelkezésre all6 beallitdsokat az el6z6 oldalon kivalasztott kotegelt mUiveletek hatédrozzak
meg. Példaul, ha az el6z6 oldalon kivalasztotta az Analyze Files (Fdjlok elemzése) m(iveletet,
akkor az szerepel az oldal navigacids ablakdban is.

15. Valassza ki a Project Translation Memories (Projekt forditasi memériak) oldalt. Ezen az
oldalon hatadrozhatja meg, hogy a program a projekt forditasi memoriat fajlalapu forditdsi
memériaként hozza létre az On gépén vagy inkabb egy szerveren hozza létre, ahol a
forditok egyszerre férhetnek hozza.
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16.

17.

18.

New Project

Batch Processing Settings
Review the project settings for the selected tashks.

== All Language Pairs Project Translation Memaries
-[& Batch Processing
Analyze Files
Pre-translate Files
Fuzzy Bands
B English (United States)->German

(%) Create file-based translation memoriss

) Create serverbased translation memories

[ < Back ” Mext =

H Finish ] [ Cancel

Ha fajlalapu forditasi memoriat szeretne, akkor ne véltoztasson az alapértelmezett

beallitdsokon, és kattintson a Finish (Befejezés) gombra.

Mikozben a program létrehozza a projektet a Preparing Project (Projekt el6készitése) oldal
jelenik meg. Az allapot sav jelzi, hogy a folyamat melyik feladatokat végezte mar el.

Ha az 6sszes feladat lefutott, a New Project (Uj projekt) varazslé bezarasahoz kattintson a
Close (Bezaras) gombra. Az igy |étrehozott Sample EN-DE projekt automatikusan megnyilik

az SDL Trados Studio-ban és aktiv projektté valik.
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Aktiv projekt

A Projects (Projektek) nézetben egyszerre tobb projekt is szerepelhet. Azonban ezek kozil
mindig csak egy lehet megnyitva, és ezt a projektet nevezzik aktiv projektnek. Amikor az
utolso feladatban létrehozott egy projektet, az automatikusan aktiv projektté valt.

e Az aktiv projekt neve az alkalmazas cimsordban jelenik meg.
e A projekt fajljai a Files (Fajlok) nézetben tekintheték meg.

e A projektrdl készitett jelentések a Reports (Jelentések) nézetben taldlhatdk.
Forditott fajlok allapota

1. AFiles (Fajlok) nézet megjelenéséhez kattintson a navigacids ablak Files (Fajlok) gombjara.

A projekthez tartozé valamennyi fjl megjelenik itt. Mindegyik fajl llapota In Translation
(Forditds alatt).

Kattintson a kiilonb6z6 fajlokra és valassza ki a képerny6 aljan taldlhato Confirmation
Statistics (Jovahagyasok statisztikaja) fllet. Ezaltal megnézheti, hogy az el6fordités soran
hadny szegmens lett leforditva.

Aktiv projekt:
Sample EN-DE
& SDL Trados Studio - Sample EN-DE
File View Project Todls Help |
] OpenDocument... (g8 New Project.. @' Open Package... a Open Server Project... | &5 2 a8
. 2| BatchTasks~ | g3l [& @] [ B & ¢ &2 8 ‘Filedetails\a‘,‘out v|
A projekt
f, | . Files 3 Mame ‘wiords Status Progress Size Usage File Type |
ajljal \ @ SamplePhotoPrinter doc sdlxliff 219 In Translat 49KB Translatable \wlord 2000
Eﬂﬁﬂ (Germany) hd Ei] SamplePresentation. ppte.sdlxliff S InTranslat. EAKE Translatable PowerPaint
Froject folders fiw, SecondSample.docx. sdixliff 136 In Translat.. TOKE Translatable ‘wiord 2007 -
=] Sample EN-DE
] My Tasks
] Sent Tasks
Jovahagyasok
statisztikdja < S
Confirmation Statistics ~ o X
Table Display: |Count ~ | Chart Display: |'\'-,'ords £
[ Include subfol
Confirmation Level ‘words Characters | Segments \sted
Mot Translated 217 987 18| | Not Translate _
fZH\ Home Draft 0 0 0
- Translated 2 14 11| Draft
u Projects Translation Rejected 0 0 0
m— Translation Approved 0 o 0
,.\{' Files Sign-off Rejected 0 0 0! | Translated
Signed Off 0 0 0
ﬁ Reports Total 219 1001 19 _
Reviewed
Q‘\ Editor
-
i’] Translation Memories Signed-off
File Details | Analysis Statistics | Confirmation Statistics | Task History
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Csomagokkal valé munka

Projektcsomag

A projektcsomag egy olyan tomaritett fajl, amely tartalmazza a projekt forditasaban résztvevé
forditoknak elkiildend6 Osszes fajlt. Ezaltal a forditok elkezdhetnek dolgozni a fajlokon.
Tartalmazhat:

e projektfajlokat: kétnyelv(i SDL XLIFF fajlok és referenciafajlok,
e projekt forditdsi memoriat,
o fajlalapu terminoldgiai adatbazisokat, forditasi memoridkat és AutoSuggest szétarakat,

e informaciokat szerveralapu forditasi memoridkhoz vagy terminoldgiai adatbazisokhoz
valé csatlakozashoz és

e projekt bedllitdsokat.

Visszakiildendé csomag

A visszakuldendé csomag (return package) olyan projektfajlokat tartalmaz, melyeken egy
bizonyos manudlis feladatot hajtottak végre. llyenek példaul a leforditott vagy ellen6rzott
projektfajlok. Tartalmazhat azonban olyan fajlokat is, melyek tovabbi munkélatokat igényelnek.
Példdul az ellenérzést végzd személy visszakildheti a leforditott f4jlt, mert forditési hiba van
benne, amit a forditénak kell kijavitania.

Amikor egy visszaklldendé csomagot hoz létre, az csak a projektfajlokat tartalmazza, a forditasi
memdriat, terminoldgiai adatbazist és az AutoSuggest szétérakat nem.

Javasolt csomaghaszndlat

Két javaslatunk van arra vonatkozdan, hogy hogyan dolgozzon munkafolyamatédban a
csomagokkal.

e Mindig hozzon létre csomagot minden egyes elvégzendé feladatrdl.

e Mindig hozzon létre visszaklildend6 csomagot minden egyes elvégzett feladatrol, és
kildje vissza azt annak a személynek, akitdl a feladatot kapta.

A javasolt munkafolyamatokrél tovabbi informécié az Offline Projekt munkafolyamat
fejezetben taldlhaté.
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Hogyan hozzunk létre projektcsomagot?

Most, hogy létrehozta sajat projektjét, a kdvetkezé [épés, hogy egy projektcsomagot is
létrehozzon. Ezutan elkiildheti azt a forditéknak, hogy elkészithessék a csomagban szerepld
fajlok forditasat. Tovabba, a forditok hasznalhatjak azokat az eréforrasokat, melyeket On a
forditas tdmogatdsara valasztott ki a projekt Iétrehozasakor.

! ...Documents\SDL Trados Studio\Projects\Sample EN-DE\Sample EN-DE.sdIproj (Ez az a projekt,
amit a legutébbi részben hozott létre.)

1. Valassza ki a Files (Fajlok) nézetben a projektben szereplé harom fajlt, majd jobb
egérgombbal kattintva valassza ki a helyi menubél a Create Project Package (Projektcsomag
létrehozasa) opciot. A meniisdvban a Project > Create Project Package (Projekt >
Projektcsomag létrehozasa) menipontra is kattinthat.

= SDL Trados Studio - Sample EN-DE

File Wiew Project Tools Help

',L:l Open Document... (g New Project... {i’ Open Package... la QOpen Server Project... |4;3_) @ (7]

|| Batch Tasks~ | i@l [ [@ ][5 B @@ &) &7 | & |Fi|e details layout v|
Files @ Name \words Status Progress Size
'@I SamplePhatoPrinter. doc. sdlxliff 219 InTranslat.
|5German (Germany) v| o 9 |n Translat.. ¥
Project folders M SecondSample.docx. sdlxliff #  Open For Translation
=Y Sample EN-DE i | Open For Review
Eﬁj My Tasks 1. | Open For Sign-off
7 Sent Tasks
B3 3
< E Create Project Package...
Create Studio 2009 Project Package...
< &
Confirmation Statistics @] | Explore Containing Folder
Table Display: | Count v =
Include subfolders a0 File With... —
O Confirmation Level Wword D F=n Isted
Naot Translated 2] flate
?.ﬂ\ Home Draft =)
' Translated -
u Projects Translation Rejected
-t Translation Approved %
L/ Files Sign-off Rejected [E] | Add Files d

2. A Create Project Package (Projektcsomag létrehozasa) vardzslé Select Files (Fajlok
kivalasztasa) oldala jelenik meg. Ahhoz, hogy a csomag tartalmazza mind a harom f4jlt,
kattintson a Next (Tovabb) gombra.
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A Project Package Options (Projektcsomag beallitasok) oldal jelenik meg. Ezen az oldalon
hatdrozhatja meg, hogy hova kivéanja menteni a projektcsomagot, illetve, hogy egy csomagot
kivan létrehozni, vagy a fajlokat tobb csomagra szeretné osztani.

3. Haszndlja az alapértelmezett beallitdsokat, és kattintson a Next (Tovabb) gombra.

o Azalapértelmezett bedllitdsok alapjan a program a ... Documents\SDL Trados
Studio\Projects mappaba menti a csomagot.

e Egy projektcsomag jott Iétre, amely tartalmazza a harom fajlt.
(b Ti Ha a projekt tobb nyelvet tartalmaz, akkor nyelvenként is készithet kiilén projektcsomagot,
Ipp . . 3 s
amelyeket ezutan elkiildhet a megfeleld forditonak.

Akar a még le nem forditott szavak szdma szerint is tovabb darabolhat egy
projektcsomagot. Ez lehetévé teszi, hogy egy nyelvpar munkajat tobb forditénak is kiadja.

Create Project Package EJ |§|gl

Project Package Options f -
Specify the folder where the project package(s) should be created and specify how the files should be divided |

into packages.

Target folder: |C:\Documents and Settings \Administrator'.My Documents*SDL Trados StudioProjects
Splitting options
(¥) Create one package

{) Create a package for every project language

)
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A Review Project Packages (Projektcsomagok attekintése) oldal jelenik meg.

4,

Adja ki a fajlok forditdsat egy felhasznalonak:

o Kattintson az Assign To (Hozzarendelés) legordiild listatdl jobbra taldlhatd Users

(Felhasznalék) gombra.

e Hozzon létre egy felhasznalét Tom Translator néven, EN-DE Translator (angol-német

fordito) leirassal.

e Az Assign To (Hozzarendelés) legordilé listabol vélassza ki a Tom Translator nevi

felhasznalot.

Mivel a fajlokat, amiket kiild, le kell forditani, gy6z6djon meg arrél, hogy a Task (Feladat)
legordilé listdban a Translate (Forditds) mivelet legyen kivalasztva.

(D Tipp Ha ellenGrzésre szeretne kikildeni fajlokat, akkor kivalaszthatja a Review (Ellendrzés)
feladatot, vagy barmely kordbban Iétrehozott testreszabott feladatot.

7.

A Comment (Megjegyzés) ablakba Tom Translator szdmara a kdvetkez6 utasitadsokat irja be:

Kérem, forditsa le ezeket a fdjlokat, majd projektcsomag formdjdban kiildje el Ralph
Reviewernek. Amikor visszakiildendé cscomag formdjdban visszakapja az ellenérzétt fdjlokat,
nyissa meg a csomagot az SDL Trados Studio-ban és hozzon létre egy Uj visszakiildendé
csomagot, amit kiildjon el nekem (a projektvezetének).

Create Project Package

Review Project Packages

Review the project packages and reamange them as required.

Packages:

Mame: |Sample EN-DE |
Assign to: |T|:um Translator V| [ |sers... ]
Task: | Translate w | [ Tasks. . ]
Due date: [ ] | | | |
Comment: | Flease tranglate these files and then send them in a project package to

Ralph Reviewer. When you receive the reviewed files in a retum

package, open the package in SOL Trados Studio and then create a

new retum package to send to me {project manager).

Name Reference File Sent Task wior
Iﬂ_1 SamplePhotoPrinter doc. sdlxd n'a ~
Eﬂ SamplePresentation. ppt.sdlxliff nla
¥ SecondSample doc sdlxliff n/a v

< >

Include subfolders Add Files...

(oo ) e

Kattintson a Next (Tovabb) gombra.
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8. Az Additional Options (Tovabbi beallitasok) oldal jelenik meg. Ezen az oldalon adhat meg
olyan tovéabbi er6forrasokat, amelyek belekeriilnek a csomagba:

e  Project Translation Memory (Projekt forditasi meméria): Alapértelmezetten a Create a
new file-based project translation memory for every package (Uj fajlalapu projekt
forditasi memoria létrehozasa minden csomag esetében) opcié van kivalasztva. Az (j
projekt forditasi memaria csak a csomagban szerepld fajlokra vonatkozo forditasi
egységeket tartalmazza.

(b Ti Akkor érdemes ezt az opciot valasztania, ha a csomag tartalma kicsi
Ipp . . ) . . e e
magahoz a projekthez képest. Egy nagy projekt teljes forditasi memoriaja
nagyméret(i projektcsomagokat hozna létre.

e File-based Resources (Fajlalapu eréforrasok): A jelol6négyzetben pipélja be az
AutoSuggest dictionaries (AutoSuggest szétarak) és a Termbases (Terminolégiai
adatbazisok) opcidkat, hogy a csomag tartalmazza a projekt eme eréforrasait.

e Kattintson a Finish (Befejezés) gombra.

MEGJEGYZES Az oldalon szerepl6 dsszes opciéra vonatkozdan tovabbi informaciét az SDL
Trados Studio Sugdjaban talal.

Create Project Package Qlilgl

Additional Options i
Specify whether to include project translation memories in the packages and whether to recompute word count |
and analysis statistics.

Project Translation Memony

(®) Create a new file-based project translation memarny for every package
) Include the existing project translation memory in every package

{7 Do not include any project translation memarias

Automated Translation
Remove automated translation provider information from the project packages

Statistics
Recompute word count and analysis statistics in order to update crossfile repetition counts

File-bazed Resources

Include the following file-based resources in the project packages:
[] Main translation memories

AutoSuggest dictionaries

Tembases

[ Finish ] [ Cancel

9. A Creating Packages (Csomagok létrehozasa) oldal jelenik meg. Ezen az oldalon kdvetheti
nyomon a projektcsomagok létrejottét, és itt valaszthatja ki, hogy milyen médon akarja a
projektcsomagokat elkiildeni:

e Ha a Send Packages by Email (Csomagok kiildése e-mailben) gombra kattint, akkor e-
mailen keresztil killdheti el a csomagot a megfelelé forditonak.

e Egy masik modszer példaul a csomag feltoltése egy FTP oldalra. A visszakildendé
csomagot tartalmazé mappa megnyitasdhoz kattintson az Open Target Folder
(Célnyelvi mappa megnyitasa) gombra.
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10. A Create Project Package (Projektcsomag létrehozasa) varazslo bezarasahoz kattintson a
Close (Bezaras) gombra.

Tegylk fel, hogy elkiildte a csomagot a forditénak. Amikor a fordité megnyitja a csomagot,
akkor forditas kdzben az 6sszes hozzaadott er6forrds automatikusan megnyilik.

Visszakiildend6 csomag megnyitdsa

Tegyuk fel, hogy a fordité (Tom Translator ) befejezte a forditast, és a lektor (Ralph Reviewer)
jovahagyta azt. Visszakiildend6 csomagot kap Tom Translatortél, amely tartalmazza a leforditott

és ellendrzott projektfajlokat.

A visszakiildend6 csomag megnyitdsahoz:

1. Kattintson a szokdsos eszkodztarban az Open Package (Csomag megnyitasa) gombra, vagy a
menisavban vélassza ki a File > Open > Package (Fajl > Megnyitas > Csomag) meniipontot.
Az Open Package (Csomag megnyitasa) varazslo jelenik meg.

2. Valassza ki a visszaklildend6 csomagot, majd kattintson az Open (Megnyitas) gombra. Az
Open Package (Csomag megnyitasa) varazslo Review Package Contents (Csomag tartalmanak
attekintése) oldala jelenik meg.

! i Ebben a részben nem fogja tudni megnyitni a minta visszakiildend6 csomagot, ha
el6tte nem kiildott egy projektcsomagot egy masik felhasznéalonak, akitél utana
nem kapott egy visszakildend6 csomagot.

Open Package g|§|g|

Review Package Contents

Review the package contents and click Finish to start importing the package.

&

Package type ReturnPackage
Project Project 3

Task Translate

Due date 03/11/2009 18:00
Assigned by  Administrator
Assigned to Translator
Customer {none)

Comment

=

{3 Include Subfolders

L MName

B SampleStudio.doc. sdlxliff

Files 1
Total words 153
Untranslated words [
Unreviewed words 135

‘words Status Progress

139 Translated

Reference File Si

l

Finish

] [ Cancel ]

3. Ellenérizze a csomag részleteit, majd valassza ki a bal alsé navigacids panelen a mappékat,
hogy megtekinthesse azok tartalmat a jobb alsé ablakban.

4. A csomag importaldsdhoz kattintson a Finish (Befejezés) gombra. Az Importing Package
(Csomag importalasa) oldal jelenik meg.
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5. Haazimportédlds befejez6dott, az Open Package (Csomag megnyitasa) varazslo bezardsahoz
kattintson a Close (Bezaras) gombra.

Az SDL Trados Studio a befejezett manualis feladatokrol sz616 informacidkkal frissiti a
medfeleld projektet.
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Projekt allapotanak nyomon kovetése

A projekt l1étrehozéasa kozben a program automatikusan generél néhany jelentést. Példaul az
Analyze Files (Fajlok elemzése) jelentést mindig generalja a program. Attdl fliggben, hogy a
projekt létrehozdsakor melyik feladatot vélasztotta ki, a program a Pre-translated Files
(El6forditott fajlok) és Apply PerfectMatch (Tokéletes egyezés alkalmazasa) jelentéseket is
automatikusan generalja.

A projekt életciklusa soran barmikor hasznalhat kotegelt miveleteket Uj vagy frissitett
jelentések Iétrehozasara. Ezek a projekt forditasanak allapotardl szolgaltatnak informaciot.
Hasznalhatja ezt a lehetdséget akkor is, ha visszaklldendé csomag formajaban megkapta az
elvégzett munkat.

A Translation Count (Forditasi egységek éllapota) jelentés a projekt forditasdnak allapotardl
szolgaltat adatokat. Példaul a forditasi egységek allapota lehet Translated (Leforditott) vagy
Translation Approved (Forditas jévahagyva). Ez kiilondsen hasznos, ha a forditas elérehaladasat
kivanja megtekinteni.

Jelentés generdldsa

Készitsen egy Translation Count (Forditasi egységek allapota) jelentést a Sample EN-DE.sdlproj
nev( projektrél, amit a kdvetkezd mappdaban hozott létre:

l ...Documents\SDL Trados Studio\Projects\Sample EN-DE\Sample EN-DE.sdlproj
o

1. A menusavban vélassza a Project > Batch Tasks > Translation Count (Projekt > Kétegelt
miiveletek > Forditasi egységek allapota) opciét. A Batch Processing (Kétegelt miiveletek
feldolgozasa) varazsld Batch Tasks (Kétegelt miiveletek) oldala jelenik meg.

Batch Processing glﬁ'@

Batch Tasks o=
5
Specify a predefined task ortask sequence to run, or create & custom task sequence. b
Task Seguence: |IEQEEILTy w | | Task Seguences...
Details
Description:

Counts the number of wards translated in the files.

s>
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Kattintson a Next (Tovabb) gombra. A Files (Fajlok) oldal jelenik meg. Az aktiv projekt
Osszes fajlja lathato itt.

Kattintson a Next (Tovabb) gombra. A Settings (Beallitasok) oldal jelenik meg.

Ennek a kdtegelt mdlveletnek a végrehajtdsahoz nem kell semmilyen beéllitdst megadnia.
A jelentés generdldsahoz kattintson a Finish (Befejezés) gombra. A Performing Tasks
(Feladatok futtatasa) oldal jelenik meg. Ha a feladat végrehajtasa befejez6dott, a
Translation Count (Forditési egységek allapota) jelentést a Reports (Jelentések) nézetben
tekintheti meg.

Zérja be a varazslot és |épjen a Reports (Jelentések) nézetbe, vagy kattintson a Task Results
(Feladat eredmények) gombra és valassza ki a jelentés megtekintése opciot a Task Results
(Feladat eredmények) parbeszédablakban.

A jelentés adatai hdrom részre vannak osztva:

e  Summary (Osszesité): Egy Osszesit6 példaul olyan informaciokat tartalmaz, mint a
projekt neve vagy a projektfajlok szdma, amely alapjan ez a jelentés késziilt.

e Totals (Osszesen): A jelentés targyat képezd Gsszes fajl allapotérdl szolgaltat
informaciot.

e  File Details (Fajl részletek): Fajlonként szolgaltat informaciot. Mivel ez a projekt harom
fajlt tartalmaz, igy mindegyikik rendelkezik egy kilon résszel a sajat forditasi
egységeik allapotéara vonatkozdan.

powered by

Translation Count Report TradosStudio

Summary

Task: Translation Count

Project: Sample EN-DE

Customer: sDL

Language: German (Germany)

Files: 3

Created At: 01/02/2010 11:57:39

Task Duration: 1 seconds

Totals

Total Status Segments Words Characters Placeables Tags

Files: 3 Not Translated 41 183 1037 38 9
Draft 0 0 0 ] 0
Translated 23 241 1131 14 7
Translation Rejected 0 0 0 0
Translation Approved 0 0 0 0
Sign-off Rejected o ] ] o
Signed Off 0 0 0 0
Total 64 424 2168 52 16

File Details

Total Status Segments Words Characters Placeables Tags

SampleFhotoPr ot Translated 1 2 14 00

inter.doc
Draft 0 0 0 0 0
Translated 18 217 Q87 12 3

gl g
,LM--.‘_JA‘ '_J“ - ---'\'”“‘-‘-Aﬂm_\‘l " "’L“"“""“--j\"\f"‘«lﬂ‘ﬂ--h..*mJ
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A projektfajlok véglegesitése

Tegyuk fel hogy a projektben szerepl6 fajlok forditdsa és ellenérzése megtortént. A kovetkezd
[épés a fajlok véglegesitése. Amikor véglegesiti fjljait, az SDL Trados Studio a kovetkezd
feladatokat hatja végre:

Frissiti a f6 forditasi memaridkat (frissiti a projekthez adott English-German.sditm forditasi
memariat. Azonban nem frissiti a projekt lIétrehozasakor generalt projekt forditasi
memoria at).

o Leforditott célnyelvi fajlokat general (a program az SDLXLIFF kiterjesztésu fajlokat az
eredeti fajlformatumba konvertélja és a német almappéba helyezi 6ket)

...Documents\SDL Trados Studio\Projects\Sample EN-DE\DE-DE

Projektfdjlok véglegesitése

A projektfajlok véglegesitéséhez:

! ...Documents\SDL Trados Studio\Projects\Sample EN-DE\Sample EN-DE.sdlproj

1.

2.

o

A menUsavban vélassza a Project > Batch Tasks > Finalize (Projekt > Kétegelt miiveletek >
Véglegesités) opciot. A Batch Processing (Kétegelt miiveletek feldolgozasa) varazslo Batch
Tasks (Kétegelt miiveletek) oldala jelenik meg.

Batch Processing glﬁ'@

Batch Tasks o=
5
Specify a predefined task ortask sequence to run, or create & custom task sequence. b
Task Sequence: + | | Task Sequences. .
Details
Description:

Update main translation memories and generate target translations for files.

Batch Tasks:

Update Main Translation Memaries
Generate Target Translations

Kattintson a Next (Tovabb) gombra. A Files (Fajlok) oldal jelenik meg. Az aktiv projekt
Osszes fajlja lathato itt.
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Kattintson a Next (Tovabb) gombra. A Settings (Beallitasok) oldal jelenik meg.

A navigdcios ablakban vélassza ki az All Language Pairs > Batch Processing > Translation
Memory Updates (Osszes nyelvpar > Kotegelt miiveletek futtatasa > Forditasi meméria
frissitése) opciot. Ez az oldal mutatja meg, hogy a forditasoknak milyen allapotban kell
lennitk ahhoz, hogy bekeriiljenek a f6 forditasi memoridba. Alapértelmezetten csak azok a
forditasok kerlilnek be a f6 forditasi memdéridba, melyek allapota Translated (Leforditott),
Translation Approved (Forditas jovahagyva) vagy Signed Off (A projektvezet6 jovahagyta).

Tegylk fel, hogy csak olyan forditast szeretne a f6 forditasi memaoriahoz adni, amelyeket
mar leellendriztek. A Translated (Leforditott) dllapot el6tti jelolénégyzetbdl vegye ki a
pipat. Ezaltal, a kotegelt mUivelet soran csak az ellenérzott és jovahagyott forditasok
kertilnek bele a forditasi memoridba.

Batch Processing glﬁ'@

Settings :__"J':
Review the relevart settings for the selected tasks and click Finish to start executing the tasks. Gt
_;é File Types Translation Memory Updates
fs Verification B = Specifywhich segments should be updated to the translation memories
= Language Pairs H and whether to add segments as new translations.

== All Language Pairs
I Translation Memory and [] Always add new translation to the translation memoary
E-[& Batch Processing

Segment status:
Translation Memory Upda g

1 Termbases [ Draft [ Mot Translated
& English (United States)->Ger [] Translated [] Translation Rejected
Translation Approved [ Sign-off Rejected
Signed Off
< >

=

A f6 forditdsi memoria frissitéséhez és a leforditott célnyelvi fjlok Iétrehozésdhoz
kattintson a Finish (Befejezés) gombra. A Performing tasks (Feladatok futtatasa) oldal jelenik
meg.

Ha a feladatok befejezédtek, kattintson a Close (Bezaras) gombra. A Files (Fajlok) nézetben
taldlhaté fajlokat a program visszakonvertalta az eredeti formatumba, ezért mar nem
szerepelnek az SDLXLIFF kiterjesztésu fajlok kozott.
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& SDL Trados Studio - Sample EN-DE

File Wiew Project Tools Help

1_3 Open Document... r"‘ Mew Project... @' Open Package... [a Open Server Project...

& e | BatehTasks= | g2l (& [ ] (5] B gl £ &l | | a8 | File details |

Files & Name WWords
|E German (Germany) v | ksl] SamplePresentation. ppbe sdlxliff 9
Project folders [[T SecondSample.docx sdhbdiff 156
=
] My Tasks

8. Valasszon ki egy féjlt a Files (Fajlok) nézetben, majd jobb egérgombbal kattintson rd, és a
helyi meniben vélassza az Explore Containing Folder (Tartalmazé mappa megnyitasa)
opciot. A projekt leforditott fajljai a de-DE nevi almappéaban, az eredeti fajlok nevével

kertilnek elmentésre. Ez ugyanaz a mappa, amely az SDLXLIFF kétnyelvd fajlokat is
tartalmazza.

@ C-\Documents and Settings\Administrator\My Documents\SDL Trados Studio\Projects\Sampl... E”E”gl

File Edit Wew Faverites Tools Help
¢ 5 ¥ P search [y Folders | [&F v X )| -
Address |[C3) C:\Documents and Settings\Administrator My Documents\SOL Trados Studio\Projects\Sample EN-DE\de-DE % | Go
Mame Size | Type Date Modified
@SamplePhntoPrinter.dnc 33KB Microsoft Office Wo... 03/02/2010 16:19
g SamplePhotoPrinter . doc. sdlxliff 46KE SDL XLIFF Document  03/02/2010 16:19
E;1S-amplEPresent.Enjnn.|3|:t &1KB Microsoft Office Po..,  03/02/2010 16:19
Q SamplePresentation. ppt. sdixliff SS5KE SDL ¥LIFF Document  03/02/2010 16:19
B secondsample. doc S2KE Microsoft Office Wo... 03/02/2010 15:1%
g SecondSample. doc. sdlxdiff 76 KB SDL XLIFF Document 03/02/2010 16:19

Ezzel befejez6dott a projekt forditasa, a leforditott fajlokat atadhatja az ligyfélnek.

Az elso lépések utmutato vége

Most mar tisztdban van azzal, hogyan hozzon Iétre és kezeljen projekteket az SDL Trados
Studio-ban. A projektek SDL Trados Studio-ban valé létrehozasaval és kezelésével kapcsolatos

tovabbi informéacidkért lasd az SDL Trados Studio Stigét. A sugot az SDL Trados Studio

menUsdvjaban taldlhatd Help > Help Topics (Sugé > Sigé témak) menlipontra kattintva éri el.
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Az SDL a globalis informaciomenedzsment (GIM) technolégiai megoldasainak piacvezetdje.

A globalis informacidmenedzsment lehet6vé teszi a vallalatok szamara, hogy kapcsolatban
maradjanak ligyfeleikkel kezdve a markaazonossagtol egészen az értékesités és ligyfélszolgalat,

illetve tamogatasig, nyelvtdl és kulturatdl fliggetlenl.

Az SDL webtartalom-kezelés, e-kereskedelem, strukturalt tartalom és nyelvtechnolégiai
megoldasai csokkentik az uj tartalmak Iétrehozasaval, azok kezelésével, forditasaval és
kozzétételével jard koltségeket. Az SDL altal kinalt innovativ szoftvertermékek felgyorsitjak a
globalis tartalomszolgaltatast, és maximalizaljak a forditas eredményességét.

Néhany globalis piacvezet6 cég, akik az SDL szoftvereit alkalmazzdk: ABN-Amro, Bosch, Canon,
CNH, FICO, GlaxoSmithKline, Hewlett-Packard, KLM, Microsoft, NetApp, Philips, SAP, Sony, stb. Az
SDL eddig tobb mint 1.500 vallalati igyféllel rendelkezik, tobb mint 185.000 licencet vonultatott
fel a forditas ellatasi lancon beliil, és havonta korilbelil 10 millié ligyfélnek biztosit hozzaférést

az igénynek megfelel6en alakitott portaljaihoz. Globalis infrastrukturaja tobb mint 60 irodabol

all 35 orszagban.
Tovabbi informaciokért latogasson el a kovetkezé oldalra:
www.sdl.com
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